EBOOK EXTRAS: v2.2

Downloads, Updates, Feedback

PHOTOS
TAKE CONTROL OF

s
’
e
l
p
p
A
r
e
t
s
a
M
r
o
f
p
p
a
s
o
t
Pho
d
a
P
i
•
e
n
o
h
Mac • iP

by JASON SNELL
$14.99

2nd

Click here to buy the full 175-page “Take Control of Photos” for only $14.99!

EDITION

Table of Contents
Read Me First ............................................................... 5
Updates and More ............................................................. 5

Introduction ................................................................ 6
Photos Quick Start ....................................................... 7
What’s New in Photos .................................................. 9
Revamped Memories ......................................................... 9
Sharing and Search Options ............................................... 9
Better Search Intelligence .................................................. 9
Import a Photos Library ..................................................... 9

Import Your Files into Photos .................................... 10
Import Files Directly ........................................................ 11
Import via USB ............................................................... 12
Manage Files Yourself on a Mac ......................................... 17

Manage Multiple Libraries on a Mac ........................... 19
Add a New Library ........................................................... 19
Switch Between Libraries .................................................. 20
Combine Your Photos Libraries .......................................... 21
Repair a Bad Library ........................................................ 22
Understand the System Photo Library ................................ 23
Use Photo Libraries on External Drives ............................... 24
Back Up Your Photos ........................................................ 25

Navigate the Photos Interface ................................... 28
Browse Your Library Through Time ..................................... 29
Explore Beyond the Photos View ........................................ 35
Filter Your View ............................................................... 37
Use the Info Window ........................................................ 39
Identify Objects in Your Images ......................................... 43
Select Text in Images ....................................................... 45
2

Click here to buy the full 175-page “Take Control of Photos” for only $14.99!

Hide Photos from View ..................................................... 46
Delete Photos ................................................................. 47
Interact With Live Photos .................................................. 48
Decorate Devices with Widgets .......................................... 49

Sync with iCloud Photos ............................................ 51
Set the System Photo Library on a Mac .............................. 51
Start Syncing With iCloud Photos ....................................... 52

Use Search to Find Your Photos ................................. 59
Embrace the Search Box .................................................. 60
Harness the Power of Categories ....................................... 62
Find Photos by Location .................................................... 65
Search in Spotlight and Siri .............................................. 67

Name and Search People ........................................... 70
Find All Photos for a Person .............................................. 70
Name and Merge People ................................................... 72

Relive Moments with Memories ................................. 79
View, Share, and Edit Memories ........................................ 80

Manually Manage Your Photos ................................... 84
Play Favorites ................................................................. 84
Organize with Keywords on a Mac ...................................... 86
Make Albums in Photos .................................................... 88

Make Quick Photo Fixes ............................................. 97
Use Auto Enhance ........................................................... 98
Rotate and Straighten Photos ............................................ 99
Give Your Photos a Filtered Look ...................................... 102
Fix Red Eye ................................................................... 103

Make Edits to Your Files ........................................... 105
Learn to Adjust Your Photos ............................................ 105
Improve Photos with Adjustments .................................... 109
Remove Blemishes and Dust on a Mac .............................. 115
Copy and Paste Adjustments on a Mac .............................. 116
Edit Live Photos ............................................................. 117
3

Click here to buy the full 175-page “Take Control of Photos” for only $14.99!

Edit Portrait Mode Photos ................................................ 120
Edit a Video on an iPhone or iPad ..................................... 123
Edit Outside of Photos .................................................... 123

Share Your Stuff ...................................................... 128
Transfer Your Stuff Directly ............................................. 128
Export and Resize Images ............................................... 129
Share via iCloud Link ..................................................... 132
Share Using Shared Albums ............................................ 136
Share in a Family ........................................................... 138
See Photos Shared by Others .......................................... 139

View Photos on Apple TV and Apple Watch .............. 143
Viewing Photos on the Apple Watch .................................. 143
View Photos on Apple TV ................................................ 148

Make Slideshows in Photos ...................................... 152
Create a Slideshow on a Mac ........................................... 153
Make Slideshows in iOS or iPadOS ................................... 158

Build Books and Calendars ...................................... 161
Design Books with Mimeo and Motif ................................. 161
Make a Calendar ............................................................ 170
Make Prints and Cards .................................................... 171

About This Book ...................................................... 172
Ebook Extras ................................................................. 172
About the Author ........................................................... 173
About the Publisher ........................................................ 174

Copyright and Fine Print .......................................... 175

4

Click here to buy the full 175-page “Take Control of Photos” for only $14.99!

Read Me First
Welcome to Take Control of Photos, Second Edition, version 2.2,
published in October 2021 by alt concepts inc. This book was written
by Jason Snell and edited by Scholle McFarland.
This book helps you get started with Apple’s Photos app on a Mac,
iPhone, and iPad. It focuses on importing libraries from older apps,
managing your media inside Photos, and using Photos to edit and
share your media with friends, relatives, and the world at large.
If you want to share this ebook with a friend, we ask that you do so
as you would with a physical book: “lend” it for a quick look, but ask
your friend to buy a copy for careful reading or reference. Discounted
classroom and user group copies are available.
Copyright © 2021, The Incomparable Inc. All rights reserved.

Updates and More
You can access extras related to this ebook on the web (use the link
in Ebook Extras, near the end; it’s available only to purchasers). On
the ebook’s Take Control Extras page, you can:
• Download any available new version of the ebook for free, or buy
any subsequent edition at a discount.
• Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading on mobile devices on our Device Advice page.)
• Read the ebook’s blog. You may find new tips or information, as
well as a link to an author interview.
If you bought this ebook from the Take Control website, it has been
added to your account, where you can download it in other formats
and access any future updates.
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Introduction
In 2002, Apple introduced iPhoto as a way for us to save our photos on
our Macs inside a “digital shoebox.” I’d owned a digital camera for
three months, and had only a few hundred digital images. Over the
years, as my photo collection grew, Apple revised iPhoto—and, in 2014,
transformed it into Photos. Over time, this has allowed Apple to unify
the photography apps it had created for its devices.
In this book, I describe how to perform essential tasks with Photos on
a Mac, iPhone, and iPad. Apple deploys some of the most powerful
functionality it has developed—including its iCloud servers and its
machine-learning technology—in the service of making your photo
collection more accessible and discoverable.
My daughter, whose birth was the motivator for my very first digitalcamera purchase, is in college now. Her entire life has been chronicled
with digital photos—tens of thousands of them at this point. That
catalog, which spent time in several photography apps including
iPhoto, now resides in my iCloud Photos, accessed via Photos on my
devices. Photography is how we preserve the images of our lives; it’s
important that we understand the software that allows us to organize,
view, and share those images. That’s what you’ll learn here.
The version of the book you are reading has been updated to reflect the
changes in Photos version 7.0, which was released along with macOS
12.0 Monterey, iOS 15, and iPadOS 15 in the fall of 2021. You can find
an overview of the changes by reading What’s New in Photos.
Thanks for joining me on this journey. Let’s get started!
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Photos Quick Start
This book explores Apple’s Photos app (in macOS, iOS, and iPadOS) by
walking you through the most essential photo-management and
editing tasks. You can read the chapters in any order. Click any link to
jump to a topic.
Find out what’s new:
• Discover what you have to look forward to with Photos in macOS 12
Monterey, iOS 15, and iPadOS 15 in What’s New in Photos.
Import and manage photos:
• Photos for macOS, iOS, and iPadOS can import files directly from
your camera or memory card. Read Import Your Files into Photos.
• On a Mac, you can switch between libraries to keep collections
separate. See Manage Multiple Libraries on a Mac.
Get organized:
• Apple includes machine-learning technology in Photos that allows
the app to identify objects, animals, and faces. Read Use Search to
Find Your Photos to take advantage of this exciting feature.
• Want to quickly round up all the photos of your kids taken with
your DSLR within the last year? Take advantage of valuable metadata in Define Smart Albums on a Mac.
Perfect your photos:
• Give photos a little extra “pop” by cropping, applying filters, and
fixing red-eye and rotation problems. See Make Quick Photo Fixes.
• Learn how to Make Edits to Your Files by removing unwanted
details and applying adjustments, as well as editing with external
apps if you prefer.
Explore your collection:
• Remember Christmas three years ago? Photos does. Peruse Photosgenerated slideshows of your photos. Check out Relive Moments
with Memories for much more.
7
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• Get a handle on how Apple automatically identifies the people in
your photos, as well as how to put names to faces in Name and
Search People.
Connect with other devices:
• Thanks to the cloud, you can access your entire photo library from
any device you own. But some Mac users may need to change the
way they think about managing their photos to make it work. Read
Sync with iCloud Photos.
• Admire your favorite photos on your big-screen TV when you View
Photos on Apple TV and Apple Watch.
Show off your photos:
• Don’t let your photos stay locked up on your Mac. Learn the easiest
ways to Share Your Stuff with others using social media and more.
• If your desired method of sharing your photos involves getting them
out of Photos, Export and Resize Images.
• Put photos right on your iPhone and iPad’s Home screen with new
widgets. See Decorate Devices with Widgets.
• Turn a special event’s photos into a beautiful movie with its own
soundtrack. See Make Slideshows in Photos.
• For all the convenience of digital photos, there’s still nothing quite
like holding an image of loved ones in your hands. Discover how to
use new third-party extension apps to design printed calendars and
books. See Build Books and Calendars.
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What’s New in Photos
In macOS 12 Monterey, iOS 15, and iPadOS 15, Photos has grown and
changed. Here are the highlights of the biggest changes in the new
versions of Photos.

Revamped Memories
Apple has completely updated the Memories feature for iOS and
iPadOS 15. There are more animations and transitions, and a wider
range of music. See Relive Moments with Memories. (The new Memories are coming to macOS Monterey with a software update in late
2021 or early 2022.)

Sharing and Search Options
The new Shared With You concept brings images out of Messages and
into your Photos Library. You can also add images from Messages to
your Photos Library with a single tap. Get all the details in See Photos
Shared by Others.

Better Search Intelligence
Apple has upgraded its photo scanning engine to recognize more kinds
of subjects. Some objects are even annotated with links from the Web.
(See Identify Objects in Your Images.) You can now use Spotlight to
search your photos in detail. See Search in Spotlight and Siri.

Import a Photos Library
Mac users can now import the contents of one Photos library into
another. Original and edited photos come over, but other metadata
does not. For the details, see Combine Your Photos Libraries.
9
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Import Your Files into
Photos
If you use iCloud Photos, the images you take on your devices automatically sync to all your other devices (see Sync with iCloud Photos), but
sometimes you may end up taking photos with a standalone camera, or
get handed a memory card or USB device loaded up with images or
videos. Photos can handle these classic methods, of course (Figure 1).

Figure 1: When you attach a camera or iOS device or insert a
memory card, Photos displays the contents in the Import pane.

You probably want to import your files directly into Photos, though
there are some instances where you might prefer to import them into
your device’s file system first and then add them to Photos later. If you
plan to modify your images in some way before Photos ingests them, or
(on a Mac) if you’d prefer to manually manage where your files are
stored, use the second approach.
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Import Files Directly
On a Mac, you can always import image and video files directly into
your library by dragging them out of Finder and into the main Photos
window, or onto the Photos icon in the Dock. You can also choose
Import from the File menu. Unless you’ve turned on the manual
management of photos (see Manage Files Yourself on a Mac), the file is
copied into the Photos Library.
On an iPhone or iPad, you can select a file in the Files app, tap the
Share icon, and choose Save Image or Save Video to import that file
into the Photos Library. If you want to select more than one file, tap
Select, select the items you’d like to import, tap Share, and tap Save
(Number) Videos or Photos (Figure 2).

Figure 2: Selecting multiple video files in the Files app.
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Manage Multiple Libraries
on a Mac
Most people will probably use a single library with Photos. But if you’re
using a Mac and want to keep strict separation between different
media collections, it’s easy to create multiple libraries in Photos and
switch between them (Figure 10).

Figure 10: Two different Photos libraries, with entirely different sets
of media.

Reasons to Have Many Libraries
There are plenty of scenarios that might lead you to want more than
one library:
✦

Create one for each client, if you’re a freelance photographer.

✦

Keep your work photos separate from the family stuff.

✦

Let your kids mess with their photos without trashing your library.

✦

Separate the files you want to sync to iCloud from ones you don’t.

Add a New Library
Here’s how to create a new Photos library:
1. Hold down the Option key as you open Photos.
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2. In the Choose Library dialog that appears (Figure 11), click the
Create New button.

Figure 11: Hold down Option while opening Photos to see the
Choose Library dialog.

Photos asks you to choose where on your Mac’s drive you want to save
the new library file.

Switch Between Libraries
Hold down the Option key as you open Photos. In the Choose Library
dialog, do one of the following:
• If one of the listed libraries is the one you want to open, select it and
click the Choose Library button.
• To open a Photos library that isn’t listed, click Other Library.
Note: The Choose Library dialog lists any importable library it can
find—the app searches your Mac for any Photos libraries as well as
not-yet-imported Aperture and iPhoto libraries.
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Navigate the Photos
Interface
The main focus of the Photos interface is the Photos view, which is
populated by a curated selection of your photos. Mac and iPad users
can navigate to other views by clicking items in the sidebar; for iPhone
users those views are in the other tabs at the bottom of the screen. If
you need to see everything, the All Photos option still shows you
everything (Figure 15).

Figure 15: While the main Photos interface is broken up into curated Years, Months, and Days views, you can still see all your photos
in the All Photos view.

If you don’t see a sidebar on your iPad, you can make it appear temporarily by swiping from the left edge of the screen. To make it appear
permanently, tap the Sidebar icon
in the upper-left corner of the
screen.
28
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Browse Your Library Through Time
The Photos view organizes your Photos library through time, with
older photos at the top and the newest ones at the very bottom. At the
top of the screen is a set of tabs that let you choose whether to view
Years, Months, Days, or All Photos. (You can also pinch, tap, or
double-click to zoom in and out of the three different view levels.)
Here’s what the different views show:
• Years: Tiles depict single years in your library (Figure 16), with
an image or video selected from the same time of year as the present
day. In the summer, you see lots of beaches. In the fall, a bunch of
kids going back to school.

Figure 16: Revisit this month in past years with the Years view.

• Months: Tiles appear in a couple of sizes (Figure 17), segmented
by Photos in an attempt to detect discrete events based on time and
location. An event might just be a single day at home, or it might be
a weeklong trip to Europe. Apple uses a massive database of loca29
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Sync with iCloud Photos
While Photos works fine as a standalone image library, it’s built to
connect with Apple’s online service, iCloud. With iCloud Photos, all
your devices can view items stored in a single online library—and add
new items to it—giving you access to every item in your media collection from any device (Figure 33).

Figure 33: Check the iCloud Photos box in Photos > Preferences >
iCloud to sync with iCloud.

Uploading your Photos Library to iCloud adds convenience and a
measure of safety to your photo collection, but there are numerous
complications to this process, too.
The Cost of Cloud Storage
As of this writing, every Apple ID comes with 5 GB of free iCloud
storage. 50 GB of iCloud space (including not just your photos but
your iPhone and iPad backups as well as iCloud Drive files) costs
$0.99 per month, 200 GB costs $2.99 per month, and 2 TB costs
$9.99 per month (To check the latest pricing and rates for different
countries, see Apple’s iCloud storage plans and pricing page.)
That’s essentially the same price as Google and Dropbox, but with
better integration and syncing on Apple devices. However, if you’re
an Amazon Prime member, you should know that Amazon Photos
offers unlimited photo storage free for Prime members. It’s worth
looking into, even if only as a second cloud backup for your images.

Set the System Photo Library on a Mac
iCloud syncing works only with a single library on your Mac, which
Apple refers to as the System Photo Library. It’s generally the first
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library that you opened when you started Photos. You can have as
many libraries as you like (see Manage Multiple Libraries on a Mac),
but only one can sync to iCloud.
To change the System Photo Library:
1. Hold down the Option key and launch Photos.
2. Select the library that you want to sync via iCloud, and click Choose
Library.
3. Choose Photos > Preferences > General.
4. Click the Use as System Photo Library button (Figure 34).

Figure 34: Click Use as System Photo Library to make your currently open library iCloud eligible.

Start Syncing With iCloud Photos
When you sync with iCloud Photos, you also have to choose which
items are retained on your device’s local storage. Here are the details.

Turn On iCloud Photos
To turn on iCloud Photos on a Mac, choose Photos > Preferences >
iCloud and select the checkbox next to iCloud Photos. Photos
immediately begins uploading the entire contents of your library to
iCloud. On an iPhone or iPad, toggle this setting on in the Photos
section of the Settings app.
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Use Search to Find Your
Photos
I used to manually tag and keyword all my digital photos and curate
photo albums for every major life event, but the number of shots I took
kept accelerating, and at some point I just gave up. I’m not alone—but
advanced computer vision technology has come to the rescue!
All the images in Photos libraries are scanned millions of times with
machine-learning algorithms to identify more than 4,000 different
scenes or objects as well as unique faces (see Name and Search People
for more on face-detection). As of iOS 15, iPadOS 15, and macOS
Monterey, it even scans for more detailed features like animal breeds
and art (see Identify Objects in Your Images for details), as well as text
that appears in your photos (see Search in Spotlight and Siri).
This makes the Search feature in Photos incredibly powerful. Want to
find a photo featuring a dog? Just type dog in the search box. The
automatically generated Dog category provides you with possibilities
(Figure 39). And that’s just the beginning. While you may want to
keep manually organizing your photo library, you may find that the
search features in Photos make that labor unnecessary.

Figure 39: Photos can do tricks like identify dogs in photos. (Nobody’s perfect, though—it also found a few cats.)
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Embrace the Search Box
Apple has spent the last few years investing enormous amounts of
resources in building machine-learning-based features for image
search. As a result, the Search feature is now probably the most important single feature in Photos. You can quickly search keywords (Figure 40), titles, or descriptions. Enter a year, or a month and a year, or
a date, and you see all the photos taken then.

Figure 40: Type the name of a location (here, the island of Maui) to
see all the pictures you took there.

I rely on the Search feature for navigating my library of more than
91,000 photos, and I highly recommend it. When in doubt, use the
search box!
On a Mac, if you don’t see the search box in the upper-right corner,
back out to a broader viewing level, such as the main level of an album.
On an iPad, there’s a Search item in the sidebar. On the iPhone, the
Search icon is located in the bottom-right corner of the screen.
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Name and Search People
Photos performs billions of computations on every photo to analyze its
contents for faces, scenes, and objects. But while Photos is good at
recognizing faces, it’s terrible at putting names to those faces. Unless
you’ve been diligent about adding everyone whose picture you take to
the Contacts app (complete with a picture that Photos can use to
identify them), you need to do some work in the People view (Figure
49), located in the sidebar on a Mac or iPad and in the People & Places
section of the Albums view on an iPhone, to teach Photos who’s who.

Figure 49: The People view is a catalog of familiar faces, and it’s
where you teach Photos who is who.

Find All Photos for a Person
The People view contains all the faces Photos has identified and
connected to a name. If you want to find photos of a specific person,
this is the place to go—just select an item to see all the photos that
Photos has matched to that face. You also find a map showing all the
places where photos of this person were taken, a list of other people
who are frequently seen with this person, and even automaticallygenerated Memories (see Relive Moments with Memories) that this
person appears in (Figure 50).
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Figure 50: The page for my friend John lets me browse all pictures,
locations, and Memories he appears in, and even shows me other
people he’s usually seen with.

Having your photos tagged based on who’s in them is a great organizational tool. For example, when it’s time to find photos of my family for
our holiday cards and annual calendars, I can use a smart album on a
71
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Relive Moments with
Memories
Memories (Figure 57) are dynamically generated slideshows that let
you relive moments without doing the work of gather everything
together yourself. Photos chooses the pictures (and videos, including
video from Live Photos), figures out an appropriate soundtrack, and
brings the whole thing to life when you tap.

Figure 57: The Memories section of For You shows collections of
images and videos that Photos thinks you might like.

On a Mac, the Memories collection is located in the sidebar. On an
iPad, it’s in the For You section on the sidebar. On an iPhone it’s on the
For You tab. Memories are organized automatically by Photos based on
a few different concepts: the recent past (“Best of Last Month”), this
same time in a previous year (“On This Day”), locations (“Kauai
through the years”), trips (“San Luis Obispo to San Diego”), individual
pets (“Pet Friends Fall 2015”), and other machine-learning-related
themes. It may seem a bit scattershot, but the idea is to help rediscover
photos that you’d never otherwise revisit.
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Note: In iOS 15 and iPadOS 15, Apple has revamped Memories
completely. The new Memories style will appear in a forthcoming
update to macOS Monterey.

In the Memories area of For You, you can tap the heart
icon to add
a Memory to your Favorites. Tap the More
button to quickly edit
the title of the Memory, tell Photos to feature some of the people in the
Memory less often (or not at all), or delete the Memory altogether.

View, Share, and Edit Memories
When you tap a Memory, it begins to play. If all you want to do is
watch, then sit back and enjoy. It plays straight through until it reaches
the end, at which point Photos offers you related Memories if you want
to watch some more.
But Memories are more than just videos. You can control them. If
there’s a photo you want to look at for a while, just tap the image and it
stays on screen—the music’s volume lowers, but the song keeps playing. You can also swipe backward if you see something you want to
look at a bit longer that has already been replaced on screen. Likewise,
you can swipe forward if there’s an image or video you want to skip.
Of course, you can do more than just watch videos. Tap once on the
screen to bring up a set of controls. From here, you can:
• Edit the music being played by the Memory by tapping the Music
icon.
• Tap or swipe between images being used in this Memory via the
thumbnails in the bottom-middle of the screen.
• Play or pause the whole thing with the Play

or Pause

icon.

• Zoom in to a gallery of all the photos in the Memory by tapping the
thumbnail
icon.
• Tap the Share
friends.

icon to save the Memory as a video or share it with
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Manually Manage Your
Photos
Apple knows most of us don’t have a lot of time to organize our photo
libraries. That’s why Photos uses machine learning to deeply analyze
each image to figure out its contents.
But not everyone is ready to embrace the power of machine learning
and let an algorithm make decisions about personal memories. That’s
why Photos also contains a set of simple organizational tools that let
you embed additional meaning into the images you’ve captured.

Play Favorites
Some of us like to precisely quantify things. I knew a kid in high school
who actually rated every movie he watched on a five-star system. (He
grew up to be a movie critic—true story!) But most of us can’t be
bothered with complex ratings systems, so Photos uses a simpler
approach: Favorites.
In All Photos and album views, all your Favorites appear with little
white hearts in their bottom-left corner (Figure 59). Awwww.
(There’s even a subtle drop shadow, so if that corner of your photo is
white, you can still see the heart.)

Figure 59: Find the fave: it’s the one with the white heart in the
bottom-left corner.
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Click Favorites in the sidebar (on an iPhone, it’s on the Albums tab) to
see just your very best shots, as judged by you (Figure 60)!

Figure 60: If I had a favorite view of my photos, it would probably
be quite similar to the Favorites view.

Make a Favorite
There are plenty of ways to mark a photo as a Favorite on a Mac:
• Select an image and then click the heart
right side of the toolbar (Figure 61).

icon located toward the

Figure 61: Show your love with the heart icon.

• Select an image and press the Period (.) key.
• Hover your pointer over the image and click the heart that appears.
• Select an image and choose Image > Add to Favorites.
• In the Info window (press ⌘-I), click the heart
right corner.

in the upper-

To favorite a photo on an iPhone or iPad, touch and hold the image
and choose Favorite from the pop-up menu. If you’re viewing the
individual image, you can also tap the heart
icon on the toolbar. (If
the heart is filled in, the image is already a favorite. You can un-favorite the photo by tapping it again.)
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Make Quick Photo Fixes
Photos has a bunch of simple tools that can improve your images
quickly and without a lot of fuss. A few don’t even require you to enter
image-editing mode. In this chapter, I focus on these “quick-fix”
options. For more advanced editing, see the next chapter, Make Edits
to Your Files.
To edit your photos, enter Edit mode. On a Mac, select an image and
press Return. (If you’re already viewing a single image, you can either
press Return or click the Edit button in the top-right corner.) Move
between different photos with the arrow keys without leaving Edit
Mode. When you’re done, click Done to exit the view. On an iPhone or
iPad, tap to open a single image and tap Edit.
When you’re in Edit mode, the entire Photos interface changes. You’ve
got access to three different sets of editing tools, which are displayed as
tabs on a Mac and as icons on an iPhone or iPad: Adjust , Filters ,
and Crop
(Figure 69). (You can also edit Live Photos from this
mode. For more information on that, see Edit Live Photos.)

Figure 69: The Edit pane consists of a large image preview, tabs,
and a strip of controls down the right side.
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Tip: Two of the quick-editing features in Photos are so quick, they
don’t even require you to enter editing mode on a Mac. These items
appear on the toolbar in the top-right corner of the Photos window.
is accessible at all times, and Auto Enhance
is accesRotation
sible after you double-click any photo. You can also press ⌘-E at any
time to auto-enhance a selected photo.

Use Auto Enhance
While Photos gives you lots of tools to tweak your images very
carefully, it also offers a sophisticated auto-enhance feature, which you
can activate by clicking the Auto Enhance icon , which is always
visible on the toolbar on a Mac, and accessible from the Adjust controls
on an iPhone or iPad. When you Enhance an image, Photos analyzes
it and makes its best guess about the proper levels, color, and more
(Figure 70).

Figure 70: The Enhance feature tries to improve your photo, but
usually doesn’t overdo it. (Here, the right image is enhanced; the left
is the original.)

Since it’s operated by a computer and not a human, the Enhance icon
won’t solve every problem. Sometimes it makes your photo look worse,
and other times it can be a bit too timid. But it’s always worth a try if
you’re not confident using the more advanced features under the
Adjust icon. Even better, Auto Enhance’s techniques aren’t meant to
be a mystery—every adjustment it makes is reflected in the detailed
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Make Edits to Your Files
Basic adjustments of the kind I described in the previous chapter,
Make Quick Photo Fixes, are often all you need to make your photos
come to life. But sometimes you need to take total control over the
situation.
On a Mac, select an image and press Return (or if you’re viewing a
single image, click the Edit button in the top-right corner) to enter Edit
mode. On an iPhone or iPad, tap to view an image and then tap the
Edit button. Then click or tap Adjust , which is an icon on an iPhone
or iPad and a tab on a Mac. You see numerous tools you can use to
make your images look their best (Figure 76).

Figure 76: Exterminate all your images’ flaws with the Adjust tab of
the Edit view.

Learn to Adjust Your Photos
The adjustment controls in Photos are slightly different on a Mac and
on an iPhone or iPad. On a Mac, you find 13 different controls on the
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right side of the window. When you hover over them, you see that
many offer an Auto button to automatically apply basic adjustments,
as well as an undo arrow
. Click the disclosure arrow to the left of
any item to see the controls that live underneath (Figure 77).

Figure 77: Many adjustment options on a Mac have a primary
control (visible once you click the disclosure arrow) made up of
component options you can display by clicking another arrow.

Many, but not all, of the adjustment controls offer an interface where
you drag a control across a horizontal bar. The center position generally means no effect is applied, while dragging to the right or left applies
an effect positively or negatively. For example, as you slide the Color
control to the right, your image becomes increasingly saturated. If you
slide it to the left, the color gradually drains away.
On an iPhone or iPad, the controls vary depending on your device and
its orientation. In Adjust mode (Figure 78), 16 controls display as
icons inside circles either on the right side of the screen (iPads and
iPhones held horizontally) or at the bottom (iPhones held vertically)
(Figure 79).
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Share Your Stuff
What good are photos and videos if you can’t share them with friends?
Traditionally, sharing photos meant sending prints or making albums.
You can still do that—see Build Books and Calendars—but sometimes
you want sharing to be more immediate. iCloud Photo Sharing lets you
share an entire album that others can update and comment on (see
Share Using Shared Albums). And if your desired sharing method
requires that you get your files out of Photos, you can do that too (see
Export and Resize Images).

Transfer Your Stuff Directly
Sometimes you just want to get your photos or videos right out of
Photos and into the hands of another person or another app. There are
lots of different ways to do this:
• Drag and drop: On a Mac, the most direct way to do this is to
select a file or files and drag them out into Finder or other apps. In
older versions of macOS, Photos didn’t play well with other apps in
terms of dragging and dropping files, but in Catalina it works pretty
much everywhere. You can also drag and drop items from Photos
into other apps using multitasking on an iPad.
• Other apps: You can pass your photos directly to another app by
tapping on the Share icon and choosing that app, whether on a
Mac, iPhone, or iPad, though there are far fewer options on a Mac.
• AirDrop: If you’re trying to directly transfer files to a device that’s
near yours (whether it’s a Mac, iPhone, or iPad), Apple’s AirDrop is
the best method to use. Click or tap the Share icon, choose AirDrop, and pick a target device. The owner of the target device is
prompted to accept the file transfer. (Your recipient may need to
adjust their AirDrop settings in order to be visible on your device.)
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• iCloud Photo Sharing: If you have this feature turned on, click or
tap the Share icon and choose Shared Albums (Mac) or Add to
Shared Album (iPhone and iPad) to add a photo to any of your
shared albums. (See Share Using Shared Albums, later in this
chapter.) Images shared using this feature are reduced to 2048
pixels on the longest edge.
Tip: Photos offers a few different ways for you to select more than
one photo for use with the Sharing menu. On a Mac Shift-click or ⌘click to select a batch of photos. On an iPhone or iPad, tap Select and
then tap or slide your finger on photos you want to select.

Export and Resize Images
Sometimes you need to export an image or collection of images, but
don’t want or need them at full resolution. (This often happens when
I’m uploading a photo as an avatar or background image for a socialmedia service, where there are very specific file-size and image-size
constraints.) This is easy to do on a Mac and more complicated on an
iPhone or iPad.

Export and Resize on a Mac
Photos for Mac’s Export command is powerful. Here’s how to use it:
1. Select the photos.
2. Choose File > Export > Export X Photos. (Where X is the number of
photos.)
3. Choose whether to export the images in JPEG, TIFF, or PNG
format; whether or not to embed metadata such as titles, keywords,
and locations; and which file naming convention to use.
4. To resize the images or set a compression level, click the disclosure
arrow by the Photo Kind pop-up menu to reveal those options.
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View Photos on Apple TV
and Apple Watch
The Photos app on the iPhone, iPad, and Mac is where Apple expects
you to manage, edit, and view photos and video. That said, there are
other devices in Apple’s ecosystem—the Apple Watch and Apple TV—
that have their part to play when it comes to enjoying photos in contexts large and small.

Viewing Photos on the Apple Watch
Apple has upgraded the Photos app in watchOS 8 to be a bit more
versatile. Now it can show photos from Memories and Featured Photos, in addition to photos synced from a single Album.

Choose What Syncs to Your Apple Watch
The Apple Watch app on your iPhone can sync favorite photos, Featured Photos, and Memories to your watch.
From the My Watch screen of the Watch iPhone app, tap Photos
(Figure 114). Toggle on Photo Syncing and then tap Sync Album to
choose the album you want. (By default, it’ll sync all your Favorites.) If
you’re concerned about filling up the storage on your watch, set a
maximum number of photos to be synced to the device by tapping
Photos Limit and choosing from options there. (By default it’s set to
100 Photos.)
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Figure 114: The Photos section of the Watch app lets you choose
what syncs to the Photos app on your Apple Watch.

You can also use the Watch app on your iPhone to choose whether or
not to automatically sync Memories and Featured Photos (from the
For You section of the app) to your watch.

View Photos on Apple Watch
The Photos app on the watch is pretty simple (Figure 115). You can
view your synced album full of photos, as well as collections of photos
in a Memory and the images that have been automatically floated to
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Make Slideshows in
Photos
I can’t go to a school function without seeing at least one slideshow.
Photos provides eight different slideshow themes (Figure 122), and if
you’re the type who wants your slideshows just so, you have a lot of
power to control exactly how yours behave.

Figure 122: The Vintage Prints theme may be my favorite of the
Photos slideshow themes.

This chapter begins by talking about the slideshow options in Photos
for Mac; for information about iPhone and iPad, read Make Slideshows
in iOS or iPadOS, at the end of the chapter.
Tip: Don’t forget that Photos can also automatically generate movies,
which are very much like slideshows, for every Memory as well as
many events in the Months and Days views. Click or tap the Play icon
at the top of any Memory. In Month and Day views, click or tap
button on a tile and choose Play Movie.
the More
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Create a Slideshow on a Mac
To create a Slideshow select a group of photos and choose File >
Create > Slideshow > Photos. Give your slideshow a name, and click
OK. A new entry appears in the My Projects section of the sidebar.
In the slideshow editor that opens, you can organize the images,
choose a theme and music, and determine how long your slideshow
lasts, as I describe next.

Choose a Theme
Click the Theme Picker
icon at the right and then click a theme
name. You can re-order the images in all themes by dragging their
thumbnails around in the strip at the bottom of the window—drag the
rule above the thumbnails up a bit if they’re too small (Figure 123).

Figure 123: Choose a theme from the list at right. You can drag
around the small images at the bottom of the screen to re-order the
Slideshow.
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Build Books and Calendars
My family has a tradition of curating our very best photos and creating
annual calendars and books. These physical products are great ways to
keep our photos in view throughout the year, even when we aren’t
staring at a device.
On a Mac you can create books and calendars directly within Photos
via third-party app extensions available for download in the Mac App
Store. These free apps allow you to create projects based on your
Photos Library and order them from right within Photos.
The story’s not as strong on an iPhone or iPad, though a recent arrival
makes it more plausible to create and order books right from your iPad
or iPhone.

Design Books with Mimeo and Motif
There are two apps that really excel at letting you build paper books
and calendars within Photos on a Mac: Mimeo Photos and Motif, both
free. I describe the process of building books in both of them below.

Build with Mimeo Photos on a Mac
I’ve been very impressed with Mimeo Photos (Figure 131). In general,
I found it to be a suitable replacement for Apple’s own book-building
tool, with some features that surpass the ones that Apple previously
offered.
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Figure 131: Mimeo Photos lets you build books within Photos, and
offers some features that Apple’s implementation never did.

To create a project using Mimeo Photos, first download the app from
the App Store. After you launch the app and give it permission to
access your photos, you can start a new project by selecting images or
an album in Photos and then choosing File > Create > Book > Mimeo
Photos.
Choose the type of book you’d like to create (Mimeo offers six styles of
hard- and softcover books). Click Create, select from one of more than
50 themes, and Mimeo generates an automatic layout based on the
images you add to the project. (I found myself deleting all those pages
and then slowly building my own.)
In the sidebar on the right side of the window, click Layout to view all
the optional layouts for a page (Figure 132). Mimeo provides dozens
of layout designs based on how many photos you want on a page or
spread.
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About This Book
Thank you for purchasing this Take Control book. We hope you find it
both useful and enjoyable to read. We welcome your comments.

Ebook Extras
You can access extras related to this ebook on the web. Once you’re
on the ebook’s Take Control Extras page, you can:
• Download any available new version of the ebook for free, or buy
a subsequent edition at a discount.
• Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading on mobile devices on our Device Advice page.)
• Read the ebook’s blog. You may find new tips or information, as
well as a link to an author interview.
• Find out if we have any update plans for the ebook.
If you bought this ebook from the Take Control website, it has been
automatically added to your account, where you can download it in
other formats and access any future updates.
More Take Control Books
This is but one of many Take Control titles! We have books that cover
a wide range of technology topics, with extra emphasis on Macs and
other Apple products.
You can buy Take Control books from the Take Control online catalog
as well as from venues such as Amazon and the Apple Books Store.
But it’s a better user experience and our authors earn more when you
buy directly from us. Just saying…
Our ebooks are available in three popular formats: PDF, EPUB, and
the Kindle’s Mobipocket. All are DRM-free.
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